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About this guide

This guide summarizes the operator instructions in the G5581A Microplate Labeler User 
Guide. 
This guide assumes the following:
• The Microplate Labeler is installed correctly, the device profile for the specific 

Microplate Labeler configuration is already created, and the teachpoints are already 
set. For setup instructions, see the G5581A Microplate Labeler User Guide.

• You are familiar with the VWorks Automation Control software. See the VWorks 
Automation Control Quick Start for an overview. For detailed instructions, see the 
VWorks Automation Control User Guide.

Note: This guide does not contain instructions for using the ActiveX Control to run the 
Microplate Labeler. For information on how to access Microplate Labeler Diagnostics 
using the ActiveX control, see the Microplate Labeler ActiveX User Guide.

Where to find the user documentation

To access the user guides for Agilent Automation Solutions products, do one of the 
following:
• From within VWorks software, select Help > Knowledge Base or press F1.
• From the Windows desktop, select Start > Agilent Technologies > 

VWorks Knowledge Base.
• Go to the online VWorks Knowledge Base at www.agilent.com/chem/askb.

Contacting Agilent Technologies

Web: https://www.agilent.com
Contact page: https://www.agilent.com/en/contact-us/page
Documentation feedback: documentation.automation@agilent.com

https://www.velocity11.com/techdocs/openingpage.html
https://www.agilent.com
https://www.agilent.com/en/contact-us/page
mailto:documentation.automation@agilent.com
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Safety guidelines

WARNING
Using controls, making adjustments, or performing procedures other than those 
specified in the user documentation can expose you to moving-parts hazards and 
hazardous voltage. Before using the Bravo Platform, make sure you are aware of the 
potential hazards and understand how to avoid being exposed to them.

Ensure that you are trained in the safe operation of the device and that you have read 
the Agilent Automation Solutions Products General Safety Guide. 

Emergency stops

If the Microplate Labeler is integrated in an automation workstation, follow the 
emergency-stop protocol for that system.

To stop the Microplate Labeler in an emergency:
1 Unplug the power cord from the Microplate Labeler or set the power switch to off 

( O ).
Make sure that the point at which the detachable power cord is connected to the 
Microplate Labeler is clear from clutter and that it is accessible at all times.

Figure Connection panel: AC power port and power switch

2 Turn off the air supply.
                                                        

00149
Vcode
power cable
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Mechanical hazards

The Microplate Labeler contains the following moving parts. 

Figure Microplate Labeler moving parts

WARNING
Pinch hazard! Do not reach between the plate stage and applicator head or between 
the applicator head and the printer while the device is on. 

WARNING
Pinch hazard! Use care when closing the printer cover. Keep clear of the cover hinges 
and do not reach into the swivel range of the cover. If you operate the printer with the 
cover open or with the cover removed, ensure that you keep clear of the exposed 
rotating parts.

Burn hazard

WARNING
The printer can become hot while printing. Do not touch the printer components 
during operation. Allow the printer to cool down before changing the media or 
cleaning the printer components.

Item Description

1 Plate stage. Automatically rotates side to side during labeling to present the 
long and short sides of a microplate to the applicator head.

2 Applicator head. Automatically rotates between the printer and the plate 
stage to apply the barcode labels.

3 Printer. Contains various parts that move automatically during a print run. 
Keep the cover closed while the device is operating. 

1               2                        3
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Hardware components 

Front view

The Microplate Labeler prints labels and applies them to labware. The device is 
comprised of a barcode applicator and a printer assembled on a baseplate. 

2

1

3

6  7
4               5

Item Feature Description

1 Printer Prints a label (600 dpi) and pauses when the label reaches the peelbar to allow 
the applicator head to retrieve the printed label. The printer supports the printing 
of linear or two-dimensional (2D) barcodes. See “Printer overview” on page 7.

2 Applicator Contains the plate stage, applicator head, green button, electronics, and the 
connection panel (back side) for the device.

3 Plate stage Provides a platform to support a plate delivered by a robot or a person. 
The plate stage rotates side to side to enable labeling on all four sides of a 
microplate. The plate stage rotation also allows the optional barcode reader to 
read any side of a microplate. 
The plate stage can move up and down to provide a choice of two vertical 
labeling positions to accommodate labware of varying heights.

4 Green button Starts a print-and-apply operation for printing test labels.

5 Applicator head Rotates between the printer and the plate stage. Uses vacuum pads (suction 
cups) to pick up a printed label from the printer and apply the label to a 
microplate on the plate stage.
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A barcode reader is connected to the side of the Microplate Labeler so that it can be 
used with the software to verify or clone barcodes.

Figure Barcode reader on Microplate Labeler

Connection panel (back view)

6 Vacuum pads Uses vacuum to pick up a label from the printer and uses compressed air to 
apply the label to a microplate on the plate stage.

7 Printer peelbar Provides a platform for presenting each label to the applicator head vacuum 
pads. As the label strip travels over the printer peelbar, each label lifts off the 
label backing slightly to allow the applicator head to pick up the label.

Item Feature Description

1

2
3
4

7

8

5

6 9
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Printer overview

CAUTION
Do not use the printer touchscreen to adjust the printer settings unless directed to do 
so by Agilent Technical Support. Using the printer touchscreen to change the printer 
settings can cause the Microplate Labeler to fail. The printer has been specially 
configured and tested as part of the Microplate Labeler at the factory. 

IMPORTANT
During operation, the software displays the operator messages and error messages on 
the computer screen. The printer touchscreen must display the Ready message before 
you can initialize the device. 

Item Feature Description

1 Air supply 
port

Connects to a compressed-air source. The device uses compressed air to:
• Move the plate stage up and down
• Rotate the applicator head side to side
• Extend and retract the applicator head
• Create a vacuum that the applicator head uses to pick up labels from the printer
• Apply labels to a microplate

2 Ethernet 
port

Connects an Ethernet cable from the controlling computer to the Microplate Labeler 
for communication.

IMPORTANT Ethernet is the recommended mode of communication. If you 
connect to the device using the Ethernet port, you do not use the serial port.

3 Barcode 
reader port

Connects the cable from the barcode reader to the Microplate Labeler for 
communication.

4 Serial port If used, connects a serial cable from the controlling computer to the device to provide 
serial communication.
Note: A serial connection may be used if you cannot establish an Ethernet connection. 
Ethernet is the recommended mode of communication. 

5 Power 
switch

Turns on (|) or off (o) the power.

6 AC power 
port

Connects the power cable.

7 Pressure 
gauge

Indicates the regulated air pressure.

8 Air pressure 
regulator

Regulates the incoming air pressure to ensure that the device’s internal components 
are not exposed to air pressure that is too high. 

9 Fuse holder Houses the universal voltage fuse.
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Figure Printer front view: (1) cover and (2) touchscreen

• Cover. Opens to provide access for cleaning the printer components and changing 
the media.

• Touchscreen. Displays the Ready message and provides access to the  Help 
menu that contains how-to videos for maintaining the printer. Service-related 
messages are also displayed on the touchscreen, 

Loading labels and ribbon

Before you start

Ensure that you have the Agilent Microplate Labeler Media Kit. The kit contains a one-
to-one quantity of ribbon and labels so that you can replace them at the same time. The 
kit contents are roll of labels, thermal transfer ribbon, empty ribbon core (functions as a 
spool to rewind the used ribbon), and cleaning pen

WARNING
The printhead can be hot after use. Allow the printhead to cool before changing the 
ribbon. 

Open the printer cover to gain access for loading the labels and ribbon.

1

2
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Figure Printer (side view) showing the feed paths of the ribbon (red) and labels (blue) 

You can use the following procedures or you can access videos of how to remove and 

load the media from the  Help menu on printer touchscreen.
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Removing the used ribbon

See the following figure for the component locations referenced in the procedure.

To remove the used ribbon:
1 While firmly grasping the ribbon supply hub (1), turn the green knob clockwise 

 to contract the hub and loosen the empty roll. Slide the roll off of the hub.

2 Lift the printhead lever (2) counterclockwise to lift the printhead.
3 While firmly grasping the take-up hub (3), turn the green take-up knob clockwise 

 to contract the hub and loosen the used roll of ribbon. Slide the used roll off 
of the take-up hub.

4 Lift the remaining ribbon out of the printer.

IMPORTANT
Clean the printhead before loading the new ribbon. 

                                                        

2

1

3
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Loading the new ribbon

See the following figure for the component locations referenced in the procedure.

To load new ribbon:
1 Install the new ribbon roll on the supply hub (1) as follows:

a While firmly holding the supply hub, turn the green knob clockwise  to 
contract the hub. Slide the new ribbon roll onto the hub until it is flush against 
the printer. Ensure the ribbon feeds clockwise with the coating facing 
downward when being unwound.

b While firmly holding the hub, turn the green knob counterclockwise  to 
expand the hub and secure the ribbon roll.

2 Ensure the printhead lever (2) is up to lift the printhead, and then guide the ribbon 
under and around the printhead.

WARNING
The printhead can be hot after use. Allow the printhead to cool before changing the 
ribbon. The printhead is the narrow bar that presses the image through the ribbon 
and onto the label as the media move onto the print roller.

CAUTION
Do not touch the protective glass layer of the printhead with your fingers. A dirty 
printhead will result in a poor print image.

3 Feed the ribbon onto an empty core on the take-up hub (3) as follows:

a While firmly holding the take-up hub, turn the green knob clockwise  to 
contract the hub. Slide an empty ribbon core onto the hub until it is flush 
against the printer. 

2

1

3



Loading labels and ribbon

12 G5581A Microplate Labeler Quick Guide

b While firmly holding the hub, turn the green knob counterclockwise  to 
expand the hub and secure the ribbon core.

c Guide the ribbon under and then over the take-up hub so that it winds 
counterclockwise. Use adhesive tape to secure the end of the ribbon to the 
ribbon core. Make sure the edge of the ribbon is flush with the core against the 
printer.

4 Turn the ribbon take-up hub (3) counterclockwise to smooth out the ribbon slack.
If you are also loading labels, continue to the next procedure. If you are finished loading 
all media, turn the printhead lever (2) clockwise to lower the printhead.

Removing a used label roll

See the following figure for the component locations referenced in the procedure.

To remove a used label roll:
1 If the printhead is not already in the up position, lift the printhead lever (1) 

counterclockwise to lift the printhead.
2 Push down on the pinch-roller lever (2) to release the label strip.
3 Cut the used label strip, and wind it fully around the rewinder (3).

4 While firmly holding the rewinder (3), turn the green knob clockwise  to 
contract the rewinder and release the wound roll. 

5 Remove the wound roll. 
Note: You will remove the empty label core when you install the new label roll in 
the following procedure.

                                                        

1

2

3
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Loading the new labels

You install the labels in three basic steps:

Step 1. Installing the label roll on the roll retainer

To install the label roll on the roll retainer:

1 Turn the green locking ring (1) counterclockwise, so that the arrow points to .
2 Remove the margin stop (2).
3 On the roll retainer (3), load the new label roll so that it feeds counterclockwise with 

the label side up.
4 Reposition the margin stop (2) on the roll retainer (3).
5 While firmly pushing the margin stop against the label roll (4), turn the green locking 

ring (1) clockwise, so that the arrow points to , securing the label roll in position.

IMPORTANT
To ensure the roll feeds properly and label presentation is repeatable, the margin stop 
must be firmly in place against the label roll.

Step For this task...

1 Install the label roll on the roll retainer.

2 Feed the label strip under the printhead.

3 Secure the label strip to the rewinder.

1

3

2

4
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Step 2. Feeding the label strip under the printhead

To feed the label strip through the printhead:
1 Turn the printhead lever (5) counterclockwise to lift the printhead.
2 Slide the red guide ring (8) to the end of the axis bar.
3 Guide the label strip below the axis bar and through the label sensor (7) so that the 

label strip exits the print unit between the printhead and the print roller (6).
4 Push the guide ring (8) on the axis bar against the outer edge of the label strip.

5

7

6

8
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Step 3. Securing the label strip to the rewinder

To secure the label strip to the rewinder:
1 Push down on the pinch-roller lever (9) to lift the pinch roller off the rewind assist 

roller.
2 Guide the label strip down and under the rewind assist roller (10) toward the 

rewinder (11).

3 While holding the rewinder (11) firmly, turn the green knob clockwise  until it 
stops.

4 Insert the label strip under the three brackets on the rewinder (11), and turn the 
green knob counterclockwise  until it stops. The rewinder is fully expanded, 
gripping the label strip firmly. 
The inside edge of the label strip should be flush against the printer. 

5 Turn the rewinder (11) counterclockwise to tighten the label strip.
6 Push up on the pinch-roller lever (9) to position the pinch roller into position on the 

rewind assist roller.
7 Turn the printhead lever (12) clockwise to lower the printhead into position.
                                                        

12
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After you finish loading new ribbon and labels

Use Microplate Labeler Diagnostics to run a print-and-apply test and verify that the 
labels print correctly and the applicator head can pick up the labels from the printer. 
Optionally, you can reset the label counter in the I/O Functions tab to track the number 
of labels used.

Starting up and shutting down

Starting up the device

IMPORTANT
Follow the steps in the order shown to establish communication with the Microplate 
Labeler.

To start up the Microplate Labeler
1 Turn on the air supply. 
2 On the Microplate Labeler connection panel, check the air pressure gauge (see 

figure, 1). Verify the air pressure is set within the following range: 
0.55 MPa (80 psi) to 0.58 MPa (85 psi)

Figure Connection panel showing Ethernet connection

Note: In Microplate Labeler Diagnostics, click the I/O tab to view the air pressure 
readout after the pressure has been regulated by the internal pressure 
regulator.

3 Verify that the communication cable (2) and power cord (3) are connected, but do 
not turn on the power yet. 
Note: The figure shows an Ethernet connection. If you are using serial 
communication, the serial cable connects to the serial port.

4 If you are using an Ethernet switch, turn on the power to the Ethernet switch.

1

2

3

4



17

Opening Diagnostics

G5581A Microplate Labeler Quick Guide

5 Turn on the computer and the monitor, and wait for the Microsoft Windows 
operating system to start.

6 On the connection panel, press the power switch (4) to the on (|) position.

WARNING
The device components can move when you turn on the power and the air. Keep 
fingers, hair, clothing, and jewelry away from the Microplate Labeler while it is in 
motion. Never touch any of the moving parts or attempt to move labware while the 
Microplate Labeler is in operation. The device could pinch, pierce, or bruise you.

IMPORTANT
Ensure that the power switch on the printer remains in the on (|) position.

7 Start the automation control software, for example, start the VWorks software.
8 Initialize the device. See “Initializing the device” on page 19.

Shutting down the device

Shut down the Microplate Labeler before you install a barcode reader, perform 
maintenance, clean, or move the Microplate Labeler

To shut down the Microplate Labeler:
1 Exit the automation control software.
2 Shut down the computer and turn off the monitor.
3 On the Microplate Labeler connector panel, press the power switch to the off (o) 

position. 
4 Turn off the air supply.

Opening Diagnostics

You use Microplate Labeler Diagnostics to set up and troubleshoot the device. This 
topic describes how to open Microplate Labeler Diagnostics from the VWorks 
software. 

Opening Diagnostics from the VWorks software

To open Microplate Labeler Diagnostics from the VWorks software:
1 In the VWorks software window, ensure the correct device file is open. 

To open a device file, choose File > Open, and then select the appropriate device file 
(*.dev) in the Open dialog box.

2 In the Devices area of the opened device file tab, highlight the device icon, and then 
click Device diagnostics.
The Microplate Labeler Diagnostics window opens.
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Figure Device tab in the VWorks window

Figure Microplate Labeler Diagnostics
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Initializing the device 

To establish communication between the computer and the Microplate Labeler, you 
initialize the Microplate Labeler device. You can initialize the Microplate Labeler in the 
following ways:
• Microplate Labeler Diagnostics. To control the device using Microplate Labeler 

Diagnostics, initialize the profile in Microplate Labeler Diagnostics.
• VWorks window. When you open a protocol or device file, a Would you like to 

initialize the devices now? message appears, and enables you to initialize the 
associated devices. 
You can also initialize the device in the VWorks device manager.

Initializing the device in diagnostics

If you want to control the device using Microplate Labeler Diagnostics, you initialize the 
profile in diagnostics. 

To initialize a profile in Microplate Labeler Diagnostics:
1 Open Microplate Labeler Diagnostics.
2 In the Profiles tab, select the profile from the Profile name list.
3 Click Initialize this profile.

Figure Initialize this profile button in the Profiles tab

The Initialize this profile button label changes to Close this profile, as the following 
figure shows.
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Figure Initialized profile in the Profiles tab

Initializing the device in the VWorks device manager

To initialize the device in the VWorks device manager:
1 In the VWorks window, ensure that the device file is open and the Microplate 

Labeler device icon appears in the Devices area.
2 In the Devices area, select the Microplate Labeler device, and then click Initialize 

selected devices.

Performing a print-and-apply test

When to do a test 

Perform a print-and-apply test when first setting up your Microplate Labeler, after 
creating a new label format, when loading new labels and ribbon, or when 
troubleshooting printing problems.
Testing helps you detect problems such as:
• Incorrect height settings for the plate stage
• Incorrectly loaded label or ribbon 
• Poorly designed label formats, for example, overlapping fields, barcodes that are 

too large for the label, missing barcodes, or text fields that are too small to read
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Before you start

The following procedure assumes that:
• Microplate Labeler Diagnostics is open. For details, see “Opening Diagnostics” on 

page 17.
• The profile for your device is initialized. For details, see “Initializing the device in 

diagnostics” on page 19.

IMPORTANT
Field data entered in the Testing tab of Microplate Labeler Diagnostics is stored 
temporarily in the computer and not the printer, so it can be used for testing purposes 
only. 

Manually placing a microplate on the plate stage

To place a microplate on the plate stage:
1 Orient the microplate so that the A1 well is in the far left corner, matching the A1 

label on the plate stage.

2 Carefully lower the microplate onto the stage, making sure that the microplate lies 
flat.
When the microplate is on the plate stage, the sides of the microplate are referred 
to as north, south, east, and west, as the figure shows.
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Running the print-and-apply test

To run a print-and-apply test:

1 In the Testing tab, verify that the label format you want to use for this test is 
selected in the Format list. 
Note: You can display a preview of the label format in the Label Editor tab.

2 Under Label Data, type the text in the field box for the position that you want to test.
Note: Only the fields that are defined in the label format can be edited. Fields 
that are defined in the label format as barcode fields will be encoded into a 
barcode before printing.

3 In the Testing Options area, select Print and apply.
4 Select the compass points corresponding to one or more sides that you want to 

apply labels to, for example North and West.

IMPORTANT
Make sure that the height of the plate stage is suitable for the type of microplate being 
labeled, and that there is a microplate on the plate stage.

5 In the Number of cycles list, set the value to the number of microplates that you 
want to test label.

6 Click Run test or press the green button on the top of the device.
The first label is printed and applied to the microplate.

7 If you are test labeling multiple microplates, quickly replace the microplate on the 
plate stage with a new one. 
Repeat this step until all the test cycles are completed.
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Using the printer touchscreen

Agilent Technical Support might request the printer status information from you when 
troubleshooting the Microplate Labeler. This topic describes how to view information 
for the printer.

CAUTION
Do not use the touchscreen to adjust the printer settings unless directed to do so by 
Agilent Technical Support.The printer has been specially configured as part of the 
Microplate Labeler. Using the touchscreen menus to change the printer settings can 
cause the Microplate Labeler to fail. 

IMPORTANT
The printer display must show the Ready message before you can initialize the device. 
During operation, the software displays operator messages and error messages on the 
computer screen. 

Touchscreen start page

Figure Touchscreen start page

                                                        

Icon See...

Opens the menu.

Interrupts the print job or continues the print job.
Appears only when a print job is in progress.

Repeats the last printed label.
Available after a print job.

Cancels all print jobs and returns the printer to the Ready state.

Feeds a blank label.
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Viewing the printer menu

To view the printer menu:
1 On the printer touchscreen start page, ensure that the Ready message is displayed. 

If a message other than Ready appears, click  to stop any printing processes.

2 Click  to display the Menu page.

Figure Touchscreen Menu page

On the Menu page, you may view the following items:

 Info. Displays information about the printer, including firmware version, 
Ethernet connection, hours or operation and number of labels, and so forth.

 Help. Displays videos on how to clean the printhead, load labels, and load 
ribbon.
All other menu items are for Agilent use only.

CAUTION
Do not use the touchscreen to adjust the printer settings unless directed to do so by 
Agilent Technical Support. Using the touchscreen menus to change the printer 
settings can cause the Microplate Labeler to fail. The printer has been specially 
configured as part of the Microplate Labeler. 
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Running a labeling protocol

VWorks Administrator or Technician privileges are required to make any changes to the 
protocol task settings.

Running the protocol

The following procedure provides a simple example of how to run a protocol. Your 
steps may vary depending on your protocol.

To run the VWorks protocol:
1 Log in to VWorks and open the protocol.
2 Ensure that the labware to be labeled matches the labware specified in the 

protocol and that the labware is placed in the location specified in the protocol, for 
example, BenchCel stacker 1.

3 Ensure that the Control Toolbar displays . 

If  is displayed, click the button to turn off the simulation mode.

4 Ensure that all the devices in the protocol are initialized.

Figure Example of a labeling protocol in the VWorks window

5 In the VWorks window, click Start on the Control Toolbar.
6 When the Run Configuration Wizard appears, follow the instructions in the wizard 

and click Next or Finish, as applicable:
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a Specify the number of times to run the protocol.
b Schedule the run to start. You can start the run:

• As soon as possible
• On a specific date and at a specific time

c Specify the starting barcode, if applicable. This feature requires a barcode 
scanner. 

CAUTION
If you select the As soon as possible option, the protocol can start to run immediately 
after you complete the configuration wizard. Before you click Finish, verify that the 
system is set up and the protocol is ready to run.

To monitor the progress of the run, check the Progress tab at the bottom of the VWorks 
window. 

Pausing a run

To pause and continue a run:

1 On the VWorks toolbar, click ( ).

The task currently in progress finishes before the protocol pauses. The Scheduler 
Paused dialog box opens.

2 When you are ready to resume the run, click Continue in the Scheduler Paused 
dialog box.
For details about the other options in the Scheduler Paused dialog box, see the 
VWorks Automation Control User Guide.
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Cleaning the printer components

When to do this

Clean the printhead and print roller when you replace the rolls of ribbon and labels. 
Cleaning the printhead regularly helps to ensure a consistently good printed image and 
prevents premature wear of the printhead. 
• Printhead. Substances can accumulate on the printhead leading to degradation of 

print quality. 
• Print roller. Accumulations of dirt on the print roller can impair the forward 

movement of the labels and ribbon and impair the print quality.
If the printer components appear damaged, contact Agilent Technical Support.

Before you start

Remove the labels and ribbon before you attempt to clean the printer components. For 
details, see “Loading labels and ribbon” on page 8.

WARNING
To avoid risk of electric shock, turn off the Microplate Labeler and disconnect the 
power cord before performing any maintenance or cleaning.

WARNING
The printhead is hot after use. To avoid risk of injury, ensure the printhead has 
cooled down before cleaning.

CAUTION
To avoid damage to the printhead, do not use sharp or hard objects to clean 
printhead. Do not touch the protective glass layer of printhead with your fingers.

Ensure that you have the following:
• Isopropyl alcohol and a soft, lint-free cloth to clean the print roller
• Cleaning pen from the Media Kit to clean the printhead

Alternatively, you can use a cotton swab dipped in isopropyl alcohol.
You can use the following procedure or you can access a video of how to clean the 
printhead from the Help menu on printer touchscreen.
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Procedure

The following figure shows the locations of the printer components referenced in this 
procedure.

Figure Printhead and print roller locations

To clean the printer components:
1 Ensure the printhead lever (1) is turned counterclockwise lifting the printhead (2). 
2 Use the special cleaning pen to clean the printhead surface (2). The printhead is the 

narrow bar that presses the image through the ribbon and onto the label as the 
media move into position on the print roller.
Alternatively, if you do not have the cleaning pen, use a cotton swab dipped in 
isopropyl alcohol.

3 Use isopropyl alcohol and a soft cloth to remove any deposits from the print roller 
(3).

IMPORTANT
Allow the printhead to dry for 2–3 minutes before using the printer.

1
2

3
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